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General information 

Overview 

The Keithley Instruments Automated Characterization Suite (ACS) software supports component characterization 
testing of packaged parts and wafer-level testing using a manual probe station. ACS software can be installed on 
any computer or Keithley Instruments Model 4200 Semiconductor Characterization System (4200-SCS) with a 
Microsoft® Windows® XP Professional Service Pack 3 (SP3), or Windows 7 x 86 (32 bit), or Windows 7 x 64 (64 bit) 
operating system. 

Supported models and test configurations 

NOTE Before you install ACS software on a computer, read and complete all of the pre-installation requirements 
listed in the Installation section of the Automated Characterization Suite (ACS) Reference Manual 
(document number ACS-901-01). This manual is provided in PDF format on your ACS Software CD-ROM 
(CD number ACS-950-01). 

The ACS software can be used with the following Keithley Instruments models in several different testing 
configurations: 

• Perform multi-group testing of Series 2600A System SourceMeter® instruments using ACS software 
installed on a personal computer or laptop. 

• Control Model 4200-SCS Semiconductor Characterization System hardware using ACS software installed 
on the Model 4200-SCS. 

• Perform combined group testing of both Model 4200-SCS and Series 2600A instruments using the ACS 
software’s combined test-execution engine. 

• Control other external GPIB instruments using ACS software installed on a personal computer or laptop 
(external instruments are only controlled through a GPIB cable). 

NOTE When using the current release of ACS on a 4200-SCS, you should ensure that your 4200-SCS has KTEI 
V8.2 or higher installed. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2 or later with no 
special configuration requirements.  

ACS software features  

• Supports 2600-based-RTMs, includes HCI, Fast-NBTI, TDDB_CVS, VRamp, JRamp, Iso_EM, Poly_Heater 
and Stress_Migration modules. (Need ACS-2600-RTM package license, ACS-2600-RTM is not available in 
ACS Standard Edition or using 30-day temporary license). 

• Requires ACS-2600-RTM package License. The 2600-based-RTMs not available in ACS Standard Edition. 
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• Added the Model 2651A instrument support. When connected properly, the instrument will be scanned and 
added automatically within the Hardware Configuration. 

• Added 2651A sample library ‘Sample_2651A.tsp’ under 26 TSPLib folder. 

• Added sample libraries/projects, includes 237-HV Reliability test modules, Stress Migration, Charge 
Pumping and Pulse Stress Measure Loop. 

• Improved throughput with Model 707B chassis integration. 

• Standard Kelvin configurations for both low-current and high-voltage. 

• (S530 Systems only)System specifications to the PCA (Probe Card Adapter), including CV. 

• (S5xx Systems only) Industrial PC with clean XP install (no consumer "starter" software). 

• S400 conversion tool. 

• Command line execution of common ACS project and automation functions. 

• Support for both DDC and ICL modes for Models 707B and 708B. 

• Prober chuck connection when using a switch matrix. 

• Perform diagnostic testing (for the S530 System only). 

• Ultra-fast BTI reliability testing that uses AC and DC reliability stress and measure techniques. 

• Statistics capability. 

• Debug Python modules. 

• Supports both symbol and 3-dimensional bitmaps. 

• Supports Python, Test Script Processor (TSP™), and C programming languages. 

• Available operator and engineer operation modes. 

• Performs common transistor parameter testing (for example, Vds-Id, Vgs-Id, Vg-Ig). 

• Performs life testing (TDDB, NBTI, HCI) using various projects. 

• A script editor tool allows you to view and edit test code and export it into TSP and Python language 
libraries. 

• Supports standard, XRC, and customized graphical user interfaces (GUIs) for PTMs and STMs, and can 
bind events in customized XRC styles. 

• XRC GUI Builder tool allows you to edit and view GUI layout for XRC format. 

• System information can be accessed and saved into a plain text file (.txt). 

• A system verification project can be opened from the help menu with connection information in an 
accompanying PDF.  

• CV, KI237, KI23X, KI24XX, KI37XX, and SWITCH libraries are supported. 
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ACS Features and Support SMUs 

 

Installation 

NOTE Before installing ACS software on a computer, read and complete all of the pre-installation requirements 
listed in the Installation section of the ACS Reference Manual. 

ACS software comes with an installation option that allows you to generate a 30-day temporary license for quick 
installation of the software in the field. For complete ACS software installation requirements and instructions 
(including detailed licensing information), refer to the Installation section of the ACS Reference Manual. 

Version 4.4 release 

Enhancements 

Added Windows 7 x86 (32-bit) and Windows 7 x64 (64-bit) operating system support. 

Enhanced modules to include the 2600-based RTM for HCI, Fast-NBTI, TDDB_CVS, VRamp, JRamp, Iso_EM, and 
Poly_Heater. 
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Added the Wafer Level Reliability Test and ACS-2600-RTM Manual in ACS v4.4. 

Removed the default password ‘ACSADMIN,’and there is no default password for ACS V4.4. 

Added the JRamp and TDDB test modules that support linear time, log time, and Vgate shift for data compression. 

Updated BTI projects to support a  total of six PMUs for KTE v8.2. 

Added the Stop on Compliance function for the 2600ITM, 4200ITM, and mixed model SMU ITM. 

Added 32 pin devices for the 2600-based RTM tests. 

Added a ‘Copy 1st to all’ function, which will copy the first setting of sub-device1 to all the other sub-devices. 

Added the abilitiy for you to set up automatic updates to the real-time plots. 

Added the ability to delete the temporary log file and a new one created whenever you start ACS. 

Added the option to sort 2600-based RTM test data output to generate a .csv file according to the new order. 

Support prober P300A. 

Upgraded the USB license key driver in order to support Windows 7 operating system. 

Upgraded the GeneralTestLib.py and added step setting. 

Added dual sweep and log sweep for the 4200 ITM. 

Added a function that saves test data and test status to a .xls file for manual testing on the data page. 

Support ACS RTM UAP execution for manual testing. 

Added a .csvbak file that backs up your .csv file in order to accomplish manual testing. 

Added the ability to configure the plot to refresh automatically or manually, for the 2600-based RTM tests. 

Added an Export Data function in the real-time plot window. 

Added the ability to save a .csv file while running an RTM test. 

Added tests to the S530 Diagnostic and Confidence Test rows B to C, D to E, and F to G. 

Changed settings so that the .csv file is bound with the project. 

Added 45,135,225,and 315 degree for the wafer notch. 

Allow changing of wafer flat or notch location without coordinating transformation. 

Ability to detect matrix errors as soon as they are encountered. 

Added function to identify Idsat in ACS-2600 RTM HCI test. 

Added searchX function to PTM and STM lptlib. 
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Critical fixes 

Updated the ACS Reference manual and created a new ACS 2600-based RTM User's manual. 

Added pulse_remove() to the ktmserver.exe file to fix BTI abort issues. 

Optimized the hardware scan using multiple threads to scan the hardware instead of a single thread. 

Added an XY setting 'Valid for Series' in the 2600-based RTM tests for the data plot. 

Added +,-,*, /, ^ expression to the HCI and Fast NBTI global variables. 

Repaired the memory error when loading a .kdf file in the wafer level plot or in statistics. 

Repaired the JRamp problem that does not perform the ramp. 

Repaired the ACS ITM Current Sweep setting problem. 

Repaired the HCI measure global expression so that it can be edited without inserting a global dialog. 

Repaired the formulator so that it can be removed for the ITM step function. 

Repaired the ACS RTM TDDB_CVS error that occurred when the test finished. 

Repaired the HCI and FS_NBTI tests that the fast clicking stress panel 'maximum recursion depth exceeded' so 
that it will no longer cause errors. 

Repaired the ACS RTM VRamp so that the last data sweep is correct. 

Repaired the ACS RTM JRamp Formulator functions so that they do not diappear. 

Repaired the ACS RTM JRamp Formulator so that the results are available after finishing the test. 

Repaired the Formulator function so that you can run a test on an RTM and after testing, you can add another 
formula, if needed. 

Repaired the ACS RTM WLR Formulator so that the results will display on the data sheet. 

Repaired the ACS RTM HCI WLR Formulator so that the results will display in the target setting. 

Repaired the memory error when switching from the definition to the Data tab after the test has stopped. 

Added an "Invalid" message that pops up when adding a new account and deleting it then restarting ACS with the 
user name ACSADMIN. 

Repaired the wafer map so that updates are in real time. 

Repaired the settings so that the loop number can be set to 0. 

Repaired the TDDB so that when the monitor measure takes a significant amount of time, and the test cannot be 
stopped, data for the subordinates will still be collected (both GPIB and LXI). 
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Repaired the TDDB so that when the sample interval is .1 second of Group 1 (for example, 1 group*4node), the 
real-time sample interval will be correctly set. 

Repaired the HCI GUI so that the Compliance option is updated after making an edit. 

Repaired the TDDB runtime error -286 problem. 

Repaired the General TDDB_CVS script TSP Syntax error. 

Repaired the ITM on the device level so that the ITM Data sheet will display the correct result. 

Repaired the id_vg module in the default project so that the data sheet will display correct data after running a test 
and the data will get appended. 

Repaired the VRamp so that it can return the correct data 'Tbd' when the device breaks down. 

Repaired the VRamp return status error so that if the devices break down reaching the Qmax problem. 

Repaired the subsite GUI so that it will display correctly after changing the subsite name and deselecting the Apply 
function. 

Repaired the inability to re-scan hardware due to the ACS not responding when there is a GPIB conflict. 

Repaired ACS so that it will start if a Model 4200 is defined in the ACS preferences and there is a KXCI (or other) 
error. 

Repaired ACS so that the configuration parameter that defines the windows directory path is missing or does not 
contain the paths to ndcore.dll or common.dll, it will now start. 

Repaired the sweep issue if the Model 237 stops running. 

Enabled ACS so that it will run all C Test Modules (CTM). 

Repaired the PTM GUI so that it does not disappear. 

Repaired the data output issue that affects the .csv file. 

Repaired the TDDB so that a 100pA measurement range can be used. 

Repaired the VRamp so that SMU1 and SMU2 can ramp voltage when other SMUs finishing ramping. 

Repaired the RTM VRamp partial data dropping problem. 

Repaired the statistics plot zooming function. 

Repaired the SMU Commands Calling during the CVU Test problem. 

Repaired the FastNBTI so that the down ramp of the post-test will work correctly. 

Repaired the aborting problem that ACS softeare causes for instruments if KITE goes offline. 

Repaired the Python getcommon() command so that it includes system attributes. 

Repaired the conpth and conpin commands to allow for dangerous connections. 
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Repaired the Fast NBTI spiking and hanging problem. 

Repaired the ISO_EM test so that it will not stop before meeting any failure criteria. 

Enhanced the SWEAT output file. 

Added a prompt continue or stop dialog box if a prober error occurs. 

Non-critical fixes 

The .kdf and .db file configurations depend on the project instead of the platform. 

The VRamp function allows you to set the real-time post data condition (for example, the time to post and the data 
points to post). 

Added an upgrade plot setting checkbox in the preference settings. If selected, it will update lines when the axis 
settings change. 

Added the ability for ACS to generate temporary files at all times for your reference, if needed. 

Saving CSV file related optimization: 

1. Optimized memory management and enhanced manual run to saving csv file. 

2. Optimized memory management and speed up saving automation csv file.  

3. Changed saving automation csv files from kdf folder to csv folder. 

4. Changed automation csv files saving configuration from KATS_Pref.ini to project, the settings will bound 
with project. 

5. Added basic test information into the header of csv file, including ‘Lot name', 'Wafer id', 'Project name' and 
'Time'. 

Added the system User environment and can save in support info file. 

Added and enabled a DMM function to the MDD.py module. 

Repaired the TSP matrix lpt functions; "Chuck" can be correctly connected. 

Repaired the python matrix lpt functions, 2410 SMU can be connected to multi pins now. 

Enabled the 2400 beeper for ACS V4.4. 

Enabled the BTI setting stored in output files.  

Repaired the RTM polyheater default CompI value of HeatLo. 

Repaired the ITM that Vprog log value is rounded. 

Repaired the Save as template that it no longer copies data folder. 

Added an error check in HCI exit/target condition value to force user input positive value. 
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Added an error check to HCI Stress V  when Stress V is nil. 

Repaired the HCI formula for a proper definition of  VTCI_LOG10 first parameter "U."  

Repaired the HCI sweep measure source range setting error when using best fix. 

Repaired the HCI formula that can be correctly generated when changing sweep measure to sample measure. 

Added the correct definition to SSVTCI in Data tab formulator. 

Repaired the Formulator VTCI_LOG10 of data tab. 

Removed the Data Tab formulator PCTSHIFT_T0. 

Added a message when copy first to all failed in HCI. 

Repaired the HCI GUI check for on/off sequence if shared Gate. 

Repaired the HCI & FS_NBTI percentage shift mode that it is functional when the using the result of 
PCTSHIFT_T0(). 

Changed the ACSPostArratDouble output value to 12 digits. 

Repaired the TDDB_CVS take data twice at last of stress problem. 

Enabled the FS_NBTI RTM to insert global data in Inter Stress item. 

Enabled the execendsetingFlag and defaultrangeFlag for single unit. 

Repaired the Graph spread over screen by moving separator problem. 

Repaired the HCI device2's tab displays while only 1 sub device under test problem. 

Added some limitations for RTM modules in Statistics. 

Enabled the ability to easily remove and add the same external instrument with the same GPIB address. 

Added a clear message when pre_test removes while global variable induced in meas for HCI. 

Added an error check for device name and pad name in device edit tool. 

Added an entrance for attribute T when multi devices test in HCI. 

Added a GUI check for stress time setting in HCI. 

Repaired the BTI script generation when not all subdevices selected for test. 

Repaired the TDDB test is running without end when Points setup to 1 in linear mode problem. 

Added a scrollbar enhancement for BTI stress settings. 

Repaired the X,Y value in offset settings. 

Enabled the the re-sort button to be grey while RTM test running. 
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Disabled the points if you select list of Time Array in TDDB GUI.  

Repaired the ITM sweep setting changing when changing Measure item problem. 

Repaired the JRamp missing last points when only using Vgate shift data compression problem. 

Disabled the auto scroll of scrollbar in GeneralTestLib. 

Repaired the TDDB that power off and relay off can be done when subdevice failed in parallel mode. 

Repaired the JRamp missing the last data when devices breakdown by using data compression problem. 

Repaired the JRamp to return correct breakdown data when it is stopped by compliance. 

Added an error check for TDDB_CVS GUI List mode with Insert: every stress section should be >=0.1s. 

Repaired the VTISUBMAX disappeared from HCI formulator dialog problem. 

Repaired the JRamp Sample interval for all the devices are not the same problem. 

Added an error check for Lowest V and Max Q in JRamp panel. 

Added an error check for PLC value in JRamp GUI. 

Repaired the VRamp set up test module Sequential mode and Parallel mode is disabled problem. 

Repaired the VRamp,Sample interval for all the devices are not the same problem. 

Enabled all SMUs of Group 1 can be assigned to Pad. 

Repaired the BTI test module, that if there are two formula you can change the sweep value. 

Repaired the RTM that subdevice1 can be removed from test. 

Repaired the devint() and clrcon() when using GPI and Matrix together. 

Enabled enough digits of Compl input for HCI&FSNBTI GUI. 

Repaired the Formulator in offline data plotting that it has the same function of formulator in Data Tab. 

Increased the speed when you apply the binning settings when many parameters are selected. 

Enabled the disabled items can be selected. 

Reworded the warning message when scan hardware. 

Repaired the HCI/NBTI and FS_NBTI insert global data error problem. 

Repaired the Hardware tooltips that they match in hardware change info window. 

The 'Login In Demo Mode' checkbox is selected by default when ACS starts. 

Added a message "ACS folder already exists, do you want to replace it" dialog box when ACS is reinstalled. 
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Updated the GUI for the HCI RTM. 

Repaired the ACS4.3 Manual bug for HCI/NBTI timing dialog. 

Repaired the formulator vector functions. 

Repaired the problems that occurred when aborting test sequences that use the PMU. 

Repaired the array plotting from S4200Parlib to be orderly. 

Capitalized the date. 

Changed all "Can not" to "Cannot." 

Enhanced the ACS Prober Reference message. 

Enabled the filter of 4200 ITM. 

Changed the Delay Factor in 4200 ITM to "Sweep Delay." 

Added a status flag as result for Em_iso_test.tsp. 

Placed the bsweep, trig correct place in manual. 

Changed the note in Diagnostics module. 

Repaired the spelling error of "SLot." 

Enabled the prober returning to the home position in single wafer mode. 

Repaired the mismatching in cassette info. 

Repaired the CVU locked when several times run system mode test without reset and reconnect KXCI problem. 

Repaired the Program not responsive or “hang" problem. 

Enabled the NBTI supporting TAR_IATV(). 

Enabled the NBTI supporting VTCI_LOG10(). 

Disabled the General Purpose Instrument to follow matrix Common LO/Independent LO scheme. 

Added a Qbd log stress value as attribute. 

Repaired the ACS data disappearing in trial operation problem. 

Repaired the ACS wafer level plot problem. 

Added a function to find out Qbd breakdown in ACS and KDAT. 

Added a  breakdown judgment to limit lowest voltage in JRamp. 

Enabled the Chuck_Force items in 3730 column. 



 Automated Characterization Suite (ACS) Release Notes 
 

PA-1008 Rev. G / Dec 2011 11 

 

Repaired the 237 is not recognize after configure Hardware problem. 

Repaired the axis title and axis values over lap if more than 1 plot problem. 

Added an error checking for Groups and associated SMU's. 

Added a bsweep Python lpt for 4200.  

Enabled the 2410 over-temperature error displayed in ACS. 

Repaired the prober button is masked by abort operation problem. 

Removed the cassette map information in the project. 

Enabled the writing data to kdf after each device. 

Known issues 

The KI2651A instrument model is not supported within an ITM and 2600-based-RTMs. 

In Windows 7 operating system, you will need to keep the network cable plugged-in if you are using a license file. If 
the network cable is removed, ACS consider your license file invalid. 

In Windows 7 operating system, when you install software or update the USB license key, you may encounter a 
User Account Control (UAC) error. If you encounter this error, click the Yes button to continue and perform the 
following steps to turn off the UAC error: 

1. Go to Control Panel -> User Account and Family Safety -> User Accounts. 

2. Select a user then click Change User Account Control setting. 

3. On setting dialog, move the notify slide to Never notify and click OK to save it. 

ACS cannot scan instruments when the Series 2600A firmware is version 2.1.6 and a 2600A instrument is the 
master to a Model 2651A using a TSP-Link cable. You can refresh the 2600A firmware version to 2.1.3 or 2.1.1 to 
solve this issue. 

If you have ACS v4.2 or earlier software installed on your PC and you are updating to ACS v4.4, you will need to 
perform the following operations first: 

1. Uninstall the previous version of ACS. 

2. Go to the C:\S4200 directory on your computer and rename it to C:\S4200_old (NOTE: this only applies if 
you are NOT installing ACS on a Model 4200-SCS). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. 

4. Install ACS v4.4. 

If you cannot run the CTM after it has been complied by Visual Studio 2008, you will need to upgrade to NI-VISA 
runtime version 4.6. 
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If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the Series 2600A and 
Series 2400 instruments in the system will be set to four-wire (4-W) mode when executing a test. Also, the SMU 
Remote Sense option box in the Preference settings Misc tab will be disabled. When all the matrices are set to 
Local Sense, all of the Series 2600A and Series 2400 instruments in the system will be set to two-wire (2-W) mode 
when executing a test. It is highly recommended that all the matrices in the system are in the same mode. 

Support for the confidence check of the Model 707B matrix only in DDC mode. 

After ACS has been launched, user do not plug-out and plug-in USB GPIB cable from computer, even the USB 
cable plug-in again, ACS still lost hardware control, user need to restart ACS to solve it. 

If installing the NI GPIB driver NI-488.2 v2.7.3 or above, the NI VISA driver option is not selected as the default. 
You must choose the NI VISA option when installing the NI GPIB driver. If the NI VISA driver is not installed, the 
instruments may not respond when running a PTM. 

ACS only supports CEC488 GPIB drivers 8.2 or above. If older drivers exist, you will need to upgrade. 

The @ symbol is a key character used in ACS. It should not be used in ACS_PostData, including 
ACSPostDataFloat, ACSPostDataDouble, ACSPostArrayInt, and ACSPostArrayFloat, etc.  

Based on license mode of the USB key inserted, you can access the different modes available in ACS (for 
example, Standard, WLR, and RF). 

While importing the Model 4200 project files, if the subsite does not have any libraries and modules described then 
importing the .kpr (Keithley Project File) will fail (you will receive an error). In addition, the devices imported will 
appear incorrectly.  

By default, the beeper is disabled when executing a module. If you want to disable/enable the beeper when running 
a module, refer to the following steps:  

1. Open the file ACS_setting.ini (in the KATS folder in the ACS file directory).  

2. Find “enable” that is under the item "beeper", beeper->enable.  

3. Set the value to 1 to enable the beeper; set the value to 0 to disable the beeper.  

4. Save the file and the configuration is effective immediately. 

Within the BTI Project, and its corresponding modules, the maximum segment number per channel is 2048.  

If you receive a .dll conflict error during ACS installation, shutdown the UTMServer or the KTMServer. If they exist 
in the task manager, then click Retry to continue the installation.  

If you uninstall or reinstall KITE or GPIB drivers after ACS has been installed, ACS may not function due to .dll 
errors. To resolve this issue, you will need to reinstall ACS.  

If you uninstall the NI driver and software, you must reinstall ACS.  

If you want to use the Model 4200-ITM or Model 4200- CVU, the version of KXCI must be v8.1 or newer.  

On the Model 4200-SCS instrument, if you run a PTM immediately after running an ITM for the Model 4200-SCS, 
you will need to add the statement Get4200HWCtrl() to get control of statements in the module. The GetHWCtrl() is 
in the ACS_PostData module.  

On the Model 4200-SCS instrument, if you stop a test and the LED stays on, you will need to close ACS and reset 
the hardware (in CMD line, run resethw) for the Model 4200-SCS, then restart ACS.  
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On the Model 4200-SCS instrument, if you do not want KXCI to start when you open and run ACS, you can change 
the setting in the .ini file to avoid unnecessary hardware conflicts. You must set the start_kxci value to 0 in the 
ACS_setting.ini file to stop KXCI from running. For example, if you run CTM automation and stop the test before it’s 
finished, you may need to restart ACS because of a hardware usage conflict between CTM and KXCI.  

ACS does not support a remote connection, such as a terminal server, VNC, Windows XP remote client, etc. with 
the USB license key. If you have a requirement to use a remote connection, contact Keithley Instruments, Inc.  

In a parallel 2600-based-RTMs test, at least one subdevice with a SMU as the master node has to be selected.  

Since the release of ACS version 4.0, ACS will dynamically load the system script for UAP when running RTM 
projects. If you have an older version of ACS and install a newer version, you will need to delete preload all, delete 
all and collectgarbage UAPs before running RTM projects inherited from the previous versions.  

In the Device settings, every Pad Name subdevice must have the correct format (refer to the ACS Reference 
manual for more details).  

For a real-time plot and data display, if the volume of data is large, it may take several seconds for the data to 
update, or may cause the software to stop functioning. For example, if the real-time timer interval is set to update 
every 1 or 2 seconds, it may cause the software to not function properly. You can change the timer interval, if 
needed, in the ACS_setting.ini file.  

ACS does not support mixing Series 2600A instruments with Series 2600 instruments with the DTNS operation 
which includes RTM parallel modules.  

When ACS is installed on the Model 4200-SCS and KITE is upgraded to v8.1, you must delete the ieee_32m.dll file 
in the following location: C:\windows\system32. Once deleted, you must reinstall the CEC488 GPIB driver v8.2.  

If you encounter an error you need help with, go to the Help  Troubleshooting  Zip Support Info. The zipped file 
is saved to  ACS\KATS\support_info. Send the information file by e-mail to the following address: 
info@keithley.com  

ACS only supports the English language. Errors may occur when saving and opening ACS files if characters from 
other languages are within the names of directories on the computer. 

Updating ACS information: 

NOTE: If you have earlier software installed on your PC or Model 4200-SCS and you are updating to new version of 
ACS, you can choose following one of case to perform the operations. The following cases also apply to reinstall 
the same version of ACS. 

Directly rename C:\ACS directory (recommended) 

1. Go to the C:\ACS directory and rename it to c:\ACSx.x_old. 

2. Go to the C:\S4200 directory and rename it to C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200-SCS). 

3. Install new version of ACS, after ACS is installed, restore user projects, libraries etc. from ACSx.x_old if 
need. 

Overwrite earlier version of ACS when updating. 
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1. Go to the C:\ACS directory and copy/paste it, the ‘copy of ACS’ directory will be created, rename ‘copy of 
ACS’ directory to ACSx.x_old. 

2. Go to the C:\S4200 directory and rename it to C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200-SCS). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. (NOTE: this only applies if you have ACS v4.2 or earlier 
software installed and you are updating to ACS v4.3 or higher). 

4. Install new version of ACS. 

Remove earlier version of ACS before updating. 

1. Go to the C:\ACS directory and copy/paste it, the ‘copy of ACS’ directory will be created, rename ‘copy of 
ACS’ directory to ACSx.x_old. 

2. Remove ACS from Start -> Program -> ACS X.X -> Uninstall Automated Characterization Suite. 

3. After un-install complete, delete C:\ACS directory. 

4. Go to the C:\S4200 directory and rename it to C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200-SCS). 

5. Installing new version of ACS, after ACS is installed, restore user projects, libraries etc. from ACSx.x_old if 
need. 

NOTE: After new version of ACS updating, you still can perform the following operations to launch earlier version of 
ACS. 

1. Go to the C:\ACS directory and rename it to c:\ACS_new. 

2. Go to the C:\ACSx.x_old directory and rename it to c:\ACS. 

3. Launch ACS, earlier version of ACS should start. You can perform the adverse above steps to launch new 
version of ACS. 
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Troubleshooting ACS 

NOTE: You may choose following one of case or some cases to perform the operations to solve the problem. 

1. Common.dll error and ACS cannot launch. 

When start ACS, the Command.dll error will popup and the kits.exe.log file will generate in C:\ACS\KATS\. The 
error in kits.exe.log as below: 

 Traceback (most recent call last): 

    File "kits.py", line 25, in ? 

      File "hardwareinteg.pyc", line 44, in ? 

     File "ACSLPT.pyc", line 6, in ? 

    File "KIGPIB_KATS.pyc", line 12, in ? 

    File "KIGPIB_KATS.pyc", line 10, in __load 

 ImportError: DLL load failed: The specified module could not be found 

1. The problem may be caused if the user does not reboot after installation of ACS 

Reboot your computer. 

Launch ACS . 

2. The problem may cause by reinstalling KTEI. 

Check the C:\S4200 directory. The C:\S4200 directory should not be absent or renamed. 

If the C:\S4200 director is renamed, rename it back to C:\S4200. (NOTE: this only applies you are not removing 
KTEI when you are install ACS on a Model S4200-SCS) 

If the KTEI version is removed or reinstalled, you need to reinstall ACS. (NOTE: ACS and KTEI version share some 
dlls. You mustinstall KTEI and then install ACS.) 

Launch ACS. 

3. The problem may be caused by improper user environment variables. 

ACS user environment value path maybe changed by other installation of other software packages. . 

Run ‘Initialize New User’ tool from Start -> Program -> ACS X.X. (Recommended) 

Reboot you computer after new user initialization is complete.. 

Launch ACS  

Also you can manually check the user environment and modify value path. (Advance) 
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Go to C:\ACS\KATS\ACS_Env.txt and open it. 

Go to My Computer -> Properties -> Advance page, click user environment button to open environment dialog, 
compare the user environment value path with ACS_Env.txt file, the path, and pyLibrary etc. value path should 
exist, especially keep the ACS related value path keep in path header, for example the path value as below: 
Path=C:\ACS\KATS;C:\S4200\sys\bin;C:\S4200\kiuser\usrlib;C:\S4200\sys\openint\dll;’ 

Click OK button to exit user environment dialog. 

Launch ACS. 

4. The problem may be caused by launching ACS from a different Windows user account. 

Log into new user account. 

Ensure you have C:\access rights. (NOTE: this only applies windows limited users without C:\ access rights) 

Run ‘Initialize New User’ tool from Start -> Program -> ACS X.X. 

Reboot you computer after initialize user finished. 

Launch ACS. 

5. The problem may cause by other software with common.dll file. 

The other error in kits.exe.log as below: 

 Traceback (most recent call last): 

    File "kits.py", line 24, in ? 

    File "hardwareinteg.pyc", line 31, in ? 

    File "ACSLPT.pyc", line 3, in ? 

    File "KILPT.pyc", line 12, in ? 

    File "KILPT.pyc", line 10, in __load 

 ImportError: DLL load failed with error code 193 (xxx) 

Go to C:\S4200\sys\bin\ directory and check if the command.dll exists. 

Search command.dll in C disk and ensure without multi common.dll file exists. 

Go to My Computer -> Properties -> Advance page, click user environment button to open environment dialog, the 
following S4200 related path value should exist in path: 
‘Path=C:\S4200\sys\bin;C:\S4200\kiuser\usrlib;C:\S4200\sys\openint\dll;’ 

Click ok button and launch ACS the problem will be solved. 

2. ACS fails to launch . Only a kits.exe.log file is generated. 

Launch ACS, the error occurrs and a kits.exe.log file is generated in C:\ACS\KATS\. 
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The error in kits.exe.log is as below: 

 Traceback (most recent call last): 

  File "kits.py", line 24, in? 

  File "hardwareinteg.pyc", line 31, in? 

  File "ACSLPT.pyc", line 7, in? 

 ImportError: No module named ptmlpt.constantlpt 

1. The problem may be caused by pyLibrary value path error in user environment. 

Go to My Computer -> Properties -> Advance page, click user environment button to open environment dialog, the 
pyLibrary value path should match ACS install path as below: ‘pyLibrary=C:\ACS\library\pyLibrary’ 

Modify the value path and click OK button to exit user environment dialog. 

Launch ACS. 

2. The problem may cause by run ACS from renamed C:\ACS_xx directory.  

If you renamed C:\ACS_xx directory, rename it back to C:\ACS. 

Launch ACS from start menu or desktop icon, the problem will be solved. (NOTE: you should not double click 
kite.exe to start ACS in KATS directory after you changed ACS directory name) 

The other error in kits.exe.log as below: 

 Traceback (most recent call last): 

    File "kits.py", line 24, in ? 

    File "hardwareinteg.pyc", line 31, in ? 

    File "ACSLPT.pyc", line 3, in ? 

    File "KILPT.pyc", line 12, in ? 

    File "KILPT.pyc", line 10, in __load 

 ImportError: DLL load failed: xxxxxxx 

3. The problem may cause by remove or reinstall GPIB driver.  

Go to C:\WINDOWS\system32\ ieee_32m.dll and delete it. 

Go to C:\WINDOWS\system32\ gpib-32.dll and delete it. 

Reinstall GPIB driver. 

Reinstall ACS. 
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4. The problem may cause by install multi GPIB interface or change GPIB interface. 

Remove previous GPIB interface. 

Go to C:\WINDOWS\system32\ ieee_32m.dll and delete it. 

Go to C:\WINDOWS\system32\ gpib-32.dll and delete it. 

Reinstall GPIB driver. 

Reinstall ACS. 

3. Nivisv32.dll error and ACS cannot launch. 

The problem may cause by KTE and NI software installing, the Nivisv32.all and Visa32.dll version does not match. 
The error messengers refer to as below:  

‘The ordinal 126 could not be located in the dynamic library NIVISV32.dll’ 

‘The ordinal 18 could not be located in the dynamic library NIVISV32.dll’ 

Go to C:\WINDOWS\system32\ NiviSv32.dll and rename it. 

Go to C:\WINDOWS\system32\ Visa32.dll and rename it. 

Install ACS. 

Also you can update NI-Visa runtime 4.3 or higher version to solve this problem. 

4. LPTLIB.dll error and ACS cannot launch. 

This problem cause by KTE 6.2 or earlier KTE version is installed.  

Updating KTE v8.1 or higher version the problem will be solved. 

5. ibup.dll error break the ACS installing. 

The problem may happen when you reinstall ACS. 

Go to Windows Task Manager, kill UTMserver, KTMserver or Kits if exists. 

Reinstall ACS. 

6. ACS cannot start cause by invalid password after ACS updating. 

This problem may happened after you overwrite updating earlier ACS to ACS v4.3 or higher. 

Go to C:\ACS\KATS\KATS_pref.ini file and rename it to KATS_pref_old.ini. 

Start ACS, login as ACSADMIN and enter the default password. 

7. ACS cannot scan hardware when starts. 

Reconnect GPIB cable and TSP-Link cable and restart ACS may solve this problem. 
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Power off and power on instruments again and restart ACS may solve this problem. 

Go to C:\WINDOWS\system32\ ieee_32m.dll and renamed it to ieee_32_old.dll. 

Install ACS. 

8. ACS always goes to demo mode after I generated temporary license file 

You need to get the officially license file or USB key license; the temporary license file is expired you cannot 
continue to use it. 

 

Version 4.3.1 release 

Added KTEI version check before running BTI modules (KTEI V8.1-SP2 or higher must be in installed). 

Removed the Sorting radio box in the Summary Report panel. 

Adjusted the total allowed plots to no greater than 36 in the wafer level plot and real time plot. 

Added the CV_ACS.lib file to avoid a link error when building a library using the create_DT tool. 

Synchronized the usrlib.mak file version with KTEI so that the file will not be removed when, or if, ACS is 
uninstalled. 

Upgraded the User Accounts dialog box so that special characters cannot be entered. 

Changed the OCR Reading code for a GPIB according to the S400 code which address the reading string issue. 

Added check point in the process of launching KXCI. For example, if the UTMServer has not started, ACS will wait 
until it starts successfully. 

Model 4200 ITM updated so the call DE command will turn off the output. There is a double delay time if you abort 
between the measurement trigger and the first point data return. 

Updated PrbP8.dll for the getProberPostition.c to support both three digit and four digit coordinate values returned 
from the prober. 

Updated the ACS Reference Manual with new Statistics documentation. 

Version 4.3 release 

NOTE If you have ACS v4.2 or earlier software installed on your PC and you are updating to ACS v4.3, you will 
need to perform the following operations first: 

1. Uninstall the previous version of ACS. 

2. Go to the C:\S4200 directory on your computer and rename it to C:\S4200_old (NOTE: this only applies if 
you are NOT installing ACS on a Model 4200-SCS). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. 

4. Install ACS v4.3. 



Automated Characterization Suite (ACS) Release Notes 
 

20 PA-1008 Rev. G / Dec 2011 

 

Enhancements 

Disabled points setting in ITM linear sweep X configuration; you can only edit the step value; the points value will be 
calculated automatically according to the step value. For the log sweep X configuration, you can edit the points 
value; the step value cannot be used. 

Supported copy partial data and export all data when right-clicking at data page. 

Adjusted the access in operator mode. 

Added VALIDATE_OCR UAP to correct wafer id before it is written to the .kdf file. 

Added the 'prb_err_hdlr' UAP. If this UAP is added, the test will not stop if a prober error occurs. You will have to 
write a recovery prober error code at this point. 

Added the FUNC_GET_PRB_ERR to obtain the prober error code and prober error message; designed to use in 
prb_err_hdlr UAP. 

Opened formula for end user; the path to the formula is .\library\ExtLibrary. 

The ACS append mode was increased to default at 30.  

Added invalid project name check for Save As and Save As Template dialog. 

Added time register in Exception file. 

The project/file option only lists the available projects for the operator end user. 

Added an option to the Preferences dialog box to select or de-select prober status. 

Built in the latest version of the KXCI client tools. 

End user is not able to override Auto-Test information with the FUNC_SET_GLOBAL_VALUE UAP in 
automation_begin. 

In limit sheet setting, the report flag will affect the data output into KDF file. 

Added the UAP_VALIDATE_OCR to correct wafer id. 

Added the directory location of the .kdf files to the Preferences dialog box. 

Added compliance status checking function in the Python LPT for Series 2600A instruments. 

Added S400 LPTLIB functions that are available on S530 Parametric Test System (for example, searchX) that are 
compatible with the S400 LPTLIB commands. 

Added the S400 and S600 LPTLIB function rtfary to the STM and PTM LPTLIB commands. 

Added python LPTLIB command support for the sweepv and smeasz functions for the Model 4200-CVU. 

In the Script Editor, removed the import library function. You will have to load the library from the library drop-down 
menu. 
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The Script Editor allows a default value for a string input variable. 

Statistics was updated to allow selectable expression formats on a wafer map. 

Statistics was updated for the scale property and now can be saved or loaded. 

Statistics was updated to allow manual scale settings in the Histogram. 

Statistics was updated to allow indication lines on the Histogram and CDF. 

Added a file overwrite confirmation to the ACS Summary Report section. 

Critical fixes 

CVU test and HV Model 2410 are supported in confidence check testing for the S530 System only. 

Added support for both All wafer and Random wafer on P8 prober. 

Statistics added Histogram and CDF comparison. 

Script Editor added LUA compile tool to support the TSP syntax error check feature. 

Made user password encrypted, and added a dialog box for password management. 

Updated the KTMServer.exe file with a pcivpureset function call to fix the BTI abort issue.   

Added select or de-select option on the Preference dialog box to redirect prober status to log Window. 

Updated the diagCVU with new KXCI communication function. 

Diagnostic testing added a retest or continue feature if testing fails. 

ACS now can poll the Prober for if there is a realign error. 

Non-critical fixes 

Interlock check added in 24lpt sweep/bsweep/asweep function after output on and every 0.5s. 

Added the Model 707B/708B Reference manual to the Help drop-down menu. 

Added an ACS Programmer’s Manual that includes ACS Global Variables and Functions under the Help drop-down 
menu. 

Add S530 Documentation (S530 Administrative Guide, S530 Diagnostics Manual) under Help drop-down menu.  

Added project name 'FACTORY_UTP_CHECKOUT' to the ACS project folder. The project will be used by 
manufacturing to perform the final checkout/burn-in of all S530 systems. 

Added a prompt to continue or stop dialog box, if a prober error occurs. 

RPM: After switch to DC mode, call devclr to clear output. 
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Updated the installation register key to solve wrong sampling time. 

Changed the ACS evaluation license period from two days to 30 days. 

Changed the System Information menu to Trouble Shooting. Included a zipped support file that includes all the 
necessary files for troubleshooting. 

Repaired the ACS .csv file output that did not support subsite#x. 

Repaired SMU2 and SMU3 on a single Model 2635A that did not force a bias voltage. 

The ACS Script Editor Save icon is disabled. 

Repaired the ACS GeneralTestLib hung automation if it has sweep with step. 

Repaired the ACS Script Editor to add extraneous end statements to the TSP modules. 

Repaired the ACS GeneralTestLib trigger overrun. 

Repaired the vertical toolbar that was truncated on the test setup panel. 

Repaired the Script Editor error when inputting digits to str type. 

Repaired errors that occur in the Row-Column diagnostic testing. 

Repaired the ACS Map style that did not output a .csv file. 

Repaired the ACS ITM setting that would disengage if the subdevice was greater than 1. 

Repaired the Python LPT commands conpin and addcon that did not work properly for the CVU. 

Changed the corresponding die size x and die size y concurrently if the orientation changes. 

Repaired the ACS Weibull plot x axis if it is incorrect and does not work for the Weibull analysis. 

Repaired the CTM run problem. 

Repaired the RTM JRAMP memory error. 

Enabled the RTM JRAMP frame for PLC input. 

Disabled the RTM JRAMP limiti setting for the pre-current test. 

Repaired the ACS statistics legend overlap on the wafer. 

Repaired the ACS Wafer Level Plot overlay issue. 

The Script Editor was updated to add default imports. 

Known issues 

If you cannot run the CTM after it has been complied by Visual Studio 2008, you will need to upgrade to NI-VISA 
runtime version 4.6. 
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If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the Series 2600A and 
Series 2400 instruments in the system will be set to four-wire (4-W) mode when executing a test. Also, the SMU 
Remote Sense option box in the Preference settings Misc tab will be disabled. When all the matrices are set to 
Local Sense, all of the Series 2600A and Series 2400 instruments in the system will be set to two-wire (2-W) mode 
when executing a test. It is highly recommended that all the matrices in the system are in the same mode. 

Support for the confidence check of the Model 707B matrix only in DDC mode. 

If installing the NI GPIB driver NI-488.2 v2.7.3 or above, the NI VISA driver option is not selected as the default. 
You must choose the NI VISA option when installing the NI GPIB driver. If the NI VISA driver is not installed, the 
instruments may not respond when running a PTM. 

ACS only supports CEC488 GPIB drivers 8.2 or above. If older drivers exist, you will need to upgrade. 

The @ symbol is a key character used in ACS. It should not be used in ACS_PostData, including 
ACSPostDataFloat, ACSPostDataDouble, ACSPostArrayInt, and ACSPostArrayFloat, etc.  

Based on license mode of the USB key inserted, you can access the different modes available in ACS (for 
example, Standard, WLR, and RF)  

While importing the Model 4200 project files, if the subsite does not have any libraries and modules described then 
importing the .kpr (Keithley Project File) will fail (you will receive an error). In addition, the devices imported will 
appear incorrectly.  

By default, the beeper is disabled when executing a module. If you want to disable/enable the beeper when running 
a module, refer to the following steps:  

1. Open the file ACS_setting.ini (in the KATS folder in the ACS file directory).  

2. Find “enable” that is under the item "beeper", beeper->enable.  

3. Set the value to 1 to enable the beeper; set the value to 0 to disable the beeper.  

4. Save the file and the configuration is effective immediately  

Within the BTI Project, and its corresponding modules, the maximum segment number per channel is 2048.  

If you receive a .dll conflict error during ACS installation, shutdown the UTMServer or the KTMServer. If they exist 
in the task manager, then click Retry to continue the installation.  

If you uninstall or reinstall KITE or GPIB drivers after ACS has been installed, ACS may not function due to .dll 
errors. To resolve this issue, you will need to reinstall ACS.  

If you uninstall the NI driver and software, you must reinstall ACS.  

The diagnostic row-column mode has a conflict with the Model 7072HV card because the card contains isolated 
rows (A-B and C-H). They cannot be connected together.  

If you want to use the Model 4200-ITM or Model 4200- CVU, the version of KXCI must be v8.1 or newer.  

On the Model 4200-SCS instrument, if you run a PTM immediately after running an ITM for the Model 4200-SCS, 
you will need to add the statement Get4200HWCtrl() to get control of statements in the module. The GetHWCtrl() is 
in the ACS_PostData module.  

On the Model 4200-SCS instrument, if you stop a test and the LED stays on, you will need to close ACS and reset 
the hardware (in CMD line, run resethw) for the Model 4200-SCS, then restart ACS.  
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On the Model 4200-SCS instrument, if you do not want KXCI to start when you open and run ACS, you can change 
the setting in the .ini file to avoid unnecessary hardware conflicts. You must set the start_kxci value to 0 in the 
ACS_setting.ini file to stop KXCI from running. For example, if you run CTM automation and stop the test before it’s 
finished, you may need to restart ACS because of a hardware usage conflict between CTM and KXCI.  

ACS does not support a remote connection, such as a terminal server, VNC, Windows XP remote client, etc. with 
the USB license key. If you have a requirement to use a remote connection, contact Keithley Instruments, Inc.  

In a parallel RTM test, at least one subdevice with a SMU as the master node has to be selected.  

Since the release of ACS version 4.0, ACS will dynamically load the system script for UAP when running RTM 
projects. If you have an older version of ACS and installed a newer version, you will need to delete preload all, 
delete all and collectgarbage UAPs before running the previous version RTM projects.  

In the Device settings, every Pad Name subdevice must have the correct format (refer to the ACS Reference 
manual for more details).  

For a real-time plot and data display, if the volume of data is large, it may take several seconds for the data to 
update, or may cause the software to stop functioning. For example, if the real-time timer interval is set to update 
every 1 or 2 seconds, it may cause the software to not function properly. You can change the timer interval, if 
needed, in the ACS_setting.ini file.  

ACS does not support mixing Series 2600A instruments with Series 2600 instruments with the DTNS operation 
which includes RTM parallel modules.  

When ACS is installed on the Model 4200-SCS and KITE is upgraded to v8.1, you must delete the ieee_32m.dll file 
in the following location: C:\windows\system32. Once deleted, you must reinstall the CEC488 GPIB driver v8.2.  

If you ever encounter an error, go to the Help drop-down in ACS and select Trouble Shooting, then click Zip 
Support Info. The Zip file will be saved to the following location: ACS\KATS\support_info. Next, send the information 
file by e-mail to the following address: info@keithley.com  

ACS only supports the English language. Errors may occur when saving and opening ACS files if characters from 
other languages are within the names of directories on the computer. 

Version 4.2.5 release 

Critical fixes 

Supports S530 full-Kelvin configuration. 

Repaired BTI real-time data back issue using banding sequences. 

Repaired limitation issue in GUI list in BTI. 

Repaired pre-test and post-test inter-stress exception issue in BTI. 

Repaired double pattern created in S900 conversion. 

Repaired import WDF problem. 

ACS build incorporated latest KTEI version, upgraded to Visual Studio 2010, cleaned up unneeded files. 
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Repaired prb_error (UAP was not working). 

Non-critical fixes 

Removed the password display in user account dialog box. 

Added dialog box for password management (will not show content of any password). 

Improved operator security. 

Version 4.2 release 

Enhancements 

ACS installation enhancement, minimize overwrite of KITE files and synchronize prober drivers with KITE. 

S530 enhancements include confidence check, diagnostic, CVU and calibration/verification. 

ACS performance optimization includes start/load project, start automation and data handling. 

Added debug tools capability for Python modules. 

Hardware configuration updated for scanning Model 3401/3402. 

Critical fixes 

Diagnostic support for the S530HV Kelvin mode. 

Confidence check support for the S530HV Kelvin mode. 

Added Python LPT for the Series 2600A and 2400 instruments: bsweepi, bsweepv, trigcomp, trigig, trigil, trigvg, 
trigvl. 

Non-critical fixes 

Updated ACS to support Windows® XP multiple users; added Initialize User in Start > Programs > ACS 4.2. First, 
you will need to create a new user account that has rights to the registry table. Then you will need to click the menu 
in the new user account and restart your PC. ACS will then work for multiple logins to the Windows XP 
environment. 

Made a S530 enhancement for CVU, added CpGp through the switch compensation example project. You can find 
it in the following folder location: ACS\projects\CVU_CpGp_Compensation. 

Disabled Preferences settings for the operator mode. 

Incorporated an automatic copy function, while ACS is installing, for the KXCI patch and old KILPT.dll files, if KITE 
version is older than 7.0. 

Added a CSV file saving function for multiple groups in RTM test. 

Graphically defined a new device update by adding a pad setting dialog using the matrix mode. 
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Repaired the global variables ACS_ssite_loopNum and ACS_ssite_loop. 

Added support for exporting and importing a test tree pattern at the sub site or device level in Map mode project. 

Added a default path for importing and exporting project tests in Tools > Preferences > Path tab (C:\ACS\Projects). 

Updated the automation options: there are three options in automation; Skip 1st Wafer Load, Single Wafer, and 
Unload Wafer after test. The options have been updated in order to save in individual projects after you change an 
option, and each project has all of these options. 

Updated the use of the USB license key so that it can be used for ACS standard and ACS Basic on the same PC. 

Added LPT support for the Model 3401/3402 (34xxlpt). 

Repaired the RTM renaming issue. 

Repaired the KITE issue of entering Demo mode unless ACS has launched first. 

Repaired the missing PTM GUI after importing and switching back to the hardware configuration view. 

Added a save new project path for the S900 converter. 

Repaired the issue of not being able to find 42SMUs in the ITM after setting the IP address in the Model 4200 
settings. 

Repaired the importing S4200 project issue that resulted in an incorrect device type. 

Repaired the issue of ACS freezing when clicking on a sub site and new type of project. 

Added a new formula to the formulator: GET_LISTINDEX. 

Added an exit button to the PTM Script Editor. 

Repaired the formulator SS function. 

Added a pop-up window message to let you know that KITE is launching. 

Repaired the standard CSV file output. 

Repaired the colors in the Wafer Level Plot since they did not match the binning settings when all the sites were 
selected on a wafer. 

Added support to the PTM, STM, and ITM for the set mode setting measure.delay. 

Improved the scanning in Model 2420 in ACS hardware configuration. 

Made ACS login username and password case sensitive. 

Repaired the .kdf file data that is not complete in automation with CTM (online mode). 

Improved the module MDD.py in order to control the matrix open or close. 

Removed the calibration and verification functions from the preload functions and added a LoadFunc.stm to the 
calibration and verification project. 
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Repaired Script Editor so that library names can start with the letter “t.” 

Added support for Pattern ID so that you can log information in the log window with LogInfo. 

Updated the FS NBTI and add limit to prevent multiple sweeps. 

Updated the FS NBTI GUI checks when no terminal is selected for measurement. 

Repaired the FS NBTI so that parallel mode can be selected for the RTM. 

Repaired the FS NBTI so that the Apply to All function works correctly. 

Improved ACS v4.1 .wdf file to increase the speed of loading. 

Provided an up and down option for node in the test tree. 

Added the default to disable beep when executing a module. 

Repaired the deleted module in Script Editor so that it is refreshed in the test setup. 

Improved start ACS after set pseudo card of Model 3706. 

Improved the ability to show the whole test name in the basic monitor items in automation. 

Added capability for ACS to automatically scale graphs on the graph sheet. 

Improved the axis settings so that the minimum and maximum entry is loaded with the Auto Scale Values. 

Improved the converting a S900/S400/S600 CPF so continue process, if error occurs. 

Improved the addcon command with the Model 3706 and instruments connected to rows and pins to column. 

Repaired the CVU so that it cannot be connected by the switch control LPT. 

Improved ITM to reduce errors when conducting many samples in a test or using Ethernet communications. 

Changed the settings so that you cannot change some default values in the automation settings in order to prevent 
unnecessary errors in your tests. 

Version 4.1 release 

Enhancements 

This is the baseline release of ACS software (version 4.0).  

Critical fixes 

There were no critical fixes included in this release. See the Known issues topic for more information about 
release content. 
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Non-critical fixes 

There were no non-critical fixes included in this release. See the Known issues topic for more information about 
release content. 

Known issues 
 

Using KITE software 
version 7.0 with Model 
4200-SCS ITMs 

If you install KITE software version 7.0 and want to use a Model 4200-SCS interactive 
test module (ITM), make sure you have the newest version of the kxci_patch files in 
your S4200 folders. Compare the dates of the kxci_patch files located in the 
ACS\KATS folder with kxci_patch files in the following folders: 

• S4200\sys\bin 

• S4200\sys\include 

• S4200\sys\lib 

If any of the files in the S4200 folders are older than the file in the ACS\KATS folder, 
replace them with the newer file. 

Running a PTM after 
an ITM on a Model 
4200-SCS 

To run a Python programming language test module (PTM) after running an ITM on a Model 
4200-SCS, you must add the Get4200HWCtrl() statement to the ACS_PostData module 
(before any statements in the PTM) to get control of the hardware. 

English language 
requirement in project 
folders 

ACS software only supports the English language. You may receive errors in your tests if you 
save files in other languages in the same folders where your ACS project files are kept. 

 

If you have questions or need further assistance, contact Keithley Instruments at 1-888-KEITHLEY (534-8453) 
(U.S. only) or send email to info@keithley.com. 
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